
 
 
 
 

Microsoft Excel 2010 
Beginner Level 1 

 

Course Handbook Supplement 
 

By Richard Rost 
 
 

 
 

Published By 

Amicron Computing 

www.ExcelLearningZone.com 
 
 

First Printing 11/28/2010 
Copyright 2010 by Amicron Computing 

All Rights Reserved  
 



 
 

  

Excel 2010 Beginner Level 1  Page 2 of 42 

Welcome 
 
Welcome to Microsoft Excel 2010 Beginner Level 1. 
 
This handbook is designed to be a supplement to the full 599CD video course for Microsoft Excel 2010 
Beginner Level 1. We recommend you use this handbook to follow along with the class videos. This 
handbook is not meant as a stand-alone study guide. 
 
We do recommend that you watch the course videos one time through, paying attention to the lessons 
covered. Follow along with the course videos using this guide. Take notes on the pages where needed. 
Then, watch the videos a second time, practicing the examples yourself on your own website. 
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Introduction 
 
Welcome to Microsoft Excel 2010 Beginner Level 1, brought to you by ExcelLearningZone.com. I am 
your instructor, Richard Rost. 
 

 

 
 
 
Objectives for today’s class are to learn how about:  
 
• Excel 2010 Interface 
• Entering Data 
• Editing Data 
• Formatting 
• Basic Math 
• Save, Load, Print 
 
We will be using Microsoft Office Excel 2010 in this class. If you are using Microsoft Office Excel 2007 
or older, you should visit my website and look for my Excel 101 course that covers Excel 2007, 2003, 2002 
and 2000. Before taking this class, it is strongly recommended that you have a good understanding of how 
to use Windows. I recommend my Windows Vista 101 course, Windows XP 101 or Windows 7 101 
depending on which version you are using. Some of the skills that you learn in these courses will be helpful 
in learning Excel 2010. If you are planning on learning how to use Microsoft Word 2010 as well, I 
recommend you take my Microsoft Word 2010 Beginner Level 1 course before the Excel courses. 
 
This is the Beginner Level 1 class for Microsoft Excel 2010. This is for the beginner user who has little or 
no experience in using Microsoft Excel.  
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Lesson 1: Excel Interface – Part 1  
 
Let’s get started today by opening Microsoft Excel. I’m using Windows Vista, so go to the Start button, 
All Programs, find Microsoft Office and select Microsoft Excel: 
 

 
 
 

When you open the spreadsheet, at first glance it can be intimidating. Today we’ll learn just the features we 
need to be productive in Excel, and it’s very easy to use.  
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Before we start actually doing things in Excel, let’s look at a few different parts of the Excel interface so 
you know what you’re looking at on the screen. Keep in mind, some of my menus may be slightly different 
then what you see on your screen based on your window size.  
 
Across the top of the screen you will see the Title Bar. Mine says “Book1 – Microsoft Excel”. When we 
learn to save our workbooks, that name will change to the name of your saved workbook document. 
 

 
 
 
In the upper right corner of the window, you will see the window control buttons – Minimize, Maximize 
and Close.  In Excel there are two sets of these buttons. The top set controls Excel as a whole. The bottom 
set controls the workbook or document inside of Microsoft Excel.  
 

 
 

 
 
 

Top Set 
Bottom Set 

Window Controls 
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I cover Minimize, Maximize and Close in my Windows class, but as a quick review, Minimize will send 
Excel to my taskbar at the bottom of my screen. If I click on it with my mouse, it will restore it. If I click on 
the Maximize button, it will fill my entire screen. The Close button will shut down the Excel program and 
return me to Windows. 
 
In the upper left corner is the new File tab, which takes the place of the “File” menu or “Office Button” in 
older versions. This is where we will go to Save our workbook, Load a new one, Print our workbook, etc. 
We’ll talk about this more in a future lesson. 
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Lesson 2: Excel Interface – Part 2 
 
In this lesson we’ll continue looking at the Excel Interface. We’ll learn more about the Ribbon, Ribbon 
Tabs, Groups, Command buttons and Dialog box launchers. 
 
At the top of Excel window is the Ribbon. This is Microsoft’s new menu system that was introduced with 
Microsoft Office 2007. The Ribbon makes it much easier to find commonly used commands than previous 
versions. Plus, the Ribbon is dynamic and will change based on what task you are performing.   
 

 
 
 

Commands on the Ribbon are grouped into different tabs – Home, Insert, Page Layout, Formulas, Data, 
Review, View, Developer (may or may not be visible). 
 
If we go back to the Home tab, we will see the most commonly used buttons. As I mentioned, the Ribbon 
is dynamic. The tab that you are on may change based on what you are doing. For example, if you are 
inserting a picture, the Picture Tools Format tool will appear. We will discuss this more in a later lesson. 
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Each tab is further organized into Groups. For example, on the Home tab you will find Clipboard, Font, 
Alignment, Number, Styles, Cells and Editing groups. The purpose of these groups is to put similar 
commands together. For example, the entire Font commands are together – size, type, bold, italics, 
underline, etc. 
 

 
 
 
If you hover over one of the buttons, a pop-up appears telling you what the button will do. Pressing the 
F1button will provide you with more help if you need it. 
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Most of the commands are simple push buttons , like the Bold button (“B”). When the command is on, the 
button will appear yellow. To turn off the command, just click on it again and the button will return to 
normal. 
 

 
 

 
Some of the command buttons are in groups. For example, the Alignment buttons are grouped together – 
Left, Middle, Right . 
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Some of the commands are drop down menus. For example, to change the size of the text, click on the 
down arrow which will open up a pull down menu where we can select a different font size. If you don’t 
want to change the size, just click on the down arrow again to close the menu. 
 

 
 
 

Some of the command buttons are actually command button groups. For example, we can click on the 
down arrow next to the Underline (“U”) command to get a double underline. We’ll talk more about this 
shortly. 
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Some of the commands are grouped into galleries. For example, if you go to the Page Layout tab and click 
on the “Themes” button you will see a gallery of built-in themes. A Theme is a collection of colors, fonts 
and effects. We’ll talk more about these in a future class. 
 

 
 
 

Again, don’t let all these commands confuse you. We’re just reviewing some of these to show you the 
different types of button controls you’ll find on the Ribbon. We’ll review these commands in more detail 
as we get to them.  
 
Some of these groups have a little button in the bottom right corner. If you click on it, it will launch a 
Dialog box or a bigger menu with more options related to that group. For example, if we click on the 
button on the alignment tab as indicated, we’ll open the dialog box as shown. 
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These dialog boxes have more options for you than what you will find on the Ribbon. 
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Lesson 3: Excel Interface – Part 3 
 
In this lesson we’ll learn about the Quick Access Toolbar, the Status bar, the Zoom controls and the 
Scroll bars. 
 
In the upper left corner near the File tab, you’ll find the Quick Access Toolbar. In previous versions of 
Excel, you were able to create your own toolbar, or customize the built-in toolbars. In Office 2010 we get 
the Quick Access Toolbar which we can customize, and you can also customize the Ribbon.  
 

 
 

 
When you start Excel for the first time, by default the Quick Access Toolbar only has a few buttons on it – 
Save, Undo, Redo. You can add the commands that you use most frequently so you have easy access to it, 
which we will learn in a future lesson. 
 
Toward the bottom of the screen you’ll find the Status Bar. It generally says “Ready” when it’s ready for 
you to input data. When you start typing in data it will say “Enter”. If you select a range of numbers, it will 
give you interesting information about those numbers – like their average, count, max and sum. 
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You can also customize the Status Bar by right clicking on it. We will learn more about this in a future 
lesson as well. 
 
Next to the Status Bar you’ll find the Views buttons. They let you switch between Normal, Page Layout 
and Page Break Preview views, which we’ll talk about in a future lesson. 
 

 
 
 

The next set of buttons is the Zoom Controls. You can use these “+” and “-“ buttons to get closer to or 
further away from your spreadsheet. You can also grab the slider in the middle and slide it to zoom in and 
out that way as well. If you click on the “100%” button, you can select from a group of pre-set zoom levels. 
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Next we have our horizontal and vertical Scroll Bars. They allow us to move left and right or up and down 
within our spreadsheets. You can click on the arrow heads to move one row or column at a time, or click 
and drag the box to move more. 
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Lesson 4: Excel Interface – Part 4 
 
In this lesson we will finish looking at the Excel interface and review those features that are unique to 
Excel – Formula Bar, Parts of a Spreadsheet, Rows, Columns, Cells, Mouse Pointer and Sheet tabs. 
So far we have covered features that are the same for all the Microsoft Office applications.  
 
The Formula Bar is unique to Excel. If you click in the bar, you’ll see a blinking cursor and extra buttons 
to the left (“X”, “√” and “fx”).   
 

 
 
 

The Formula Bar will show you your formula even if numbers are in your cells. This is where you’ll click 
to find hidden formulas or other information in your spreadsheet. 
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A Spreadsheet is made of vertical columns and each column has a designated letter at the top (i.e., 
A,B,C,D, etc). It also is made up of horizontal rows that are numbered (i.e., 1,2,3,4, etc.). 
 

 
 
 
A spreadsheet consists of a couple of different things. It has Columns , which are vertical. 
 

 
 
 
And Rows, which are horizontal. 
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Each Column has a letter above it, to identify it. Each Row has a number to the left of it. 
 

 
 
 
The location where a row intersects a column is called a Cell. A Cell is defined by a column and a row. For 
example Cell E3, B2, A1, etc. When you click in a cell, you can see the cell name in the Name Box. This 
name box is useful because you can assign your own cell names as well. 
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A Cell is defined by a column and a row. For example Cell E3, B2, A1, etc. When you click in a cell, you 
can see the cell name in the Name Box. This name box is useful because you can assign your own cell 
names as well. 
 

 
 
 
The Mouse Pointer looks like a “+” when it’s over the spreadsheet. It can change depending on what 
you’re doing. For example, if you point to a command on the Ribbon, it turns into a white arrow. If you 
move it between column headings it changes into a black double pointing arrow. We’ll learn more about 
these as we go along. 
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Down toward the bottom of the spreadsheet, you have the Sheet Tabs. The Excel workbook, or file that 
you’re working with, can be made up of multiple spreadsheets. You can have as many sheets in a 
workbook as you would like. To add another sheet, click on the icon on the last sheet to “Insert 
Worksheet”. 
 

 
 

 
Generally, you use different sheets in a workbook to store related information.  You can do a lot with these 
tabs including changing their name, their color, etc.  
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Lesson 5: Entering Data 
 
In this lesson we will begin making our first spreadsheet and you will learn how to properly enter data into 
your spreadsheet. 
 
Let’s begin by entering some sample text. We’ll set up a sales summary sheet for a fictional company. 
We’ll start by typing in a list of our sales reps. 
 
Make sure you are in Cell A1. If you are not in that cell, you can click your mouse in that cell or using your 
arrow keys to move into the correct cell. Once you are in the correct cell, type “Sales Rep”. You’ll notice 
that it appears in the cell and in the Formula Bar. When you’re done, press “Enter”.  
 

 
 
 

If you’re entering data in the columns and you want to move down to the next row, you can hit the “Enter” 
key to keep moving down that column after you type in some data. Or you can simply use the down arrow 
key. If you want to move across the row into the next column, you can use the “Tab” key to move to the 
next column, or you can use the arrow keys. 
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Now let’s enter in the name of our Sales Reps. Make sure you’re sitting in Cell A2 and type in the 
following names, hitting “Enter” after each name to move down the column: 
 

 
 
 

Now move into Cell B1 either using your mouse or your arrow keys so we can enter the next column of 
data. We are tracking monthly sales for these reps, so in the Header Row or Row 1, let’s type in the 
months, using the “Tab” key after each entry to move to the next cell across the row. For this example, 
we’ll only go up to April:  
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Now let’s go ahead and type in some sales figures. Use your arrow keys to move down to Cell B2 and to 
begin entering data as follows: 
 

 
 
 

Notice how the number values align to the right of the cell and the text values align to the left. I’ll show 
you how to correct this in the next lesson. 
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Lesson 6: Editing Data 
 
In this lesson we will learn how to edit the data we just entered into our spreadsheet. 
 
We just entered our list of sales reps, the months and the sales figures for those months and reps. Let’s say 
we made an error and should have entered 62 in February for Alex’s sales figures instead of 65. Now we’ll 
have to correct that. 
 
As with everything in Excel, there are multiple ways to fix this and I will show you a few. You can pick the 
method you like best and stick with it.  
 
The first way is to simply replace it or type over it  with new data. Simply click your mouse in Cell C3 
and type over the existing data with the new information. You don’t have to delete the old data first. 
 
The second way is to use the Formula Bar. Click on Cell C3 and then click in the Formula Bar. You will 
have a blinking cursor and can edit the text any way you want. 
 
You can also edit data right in place by double clicking on the cell. By double clicking on Cell C3 it puts 
me in edit mode. You’ll notice a blinking cursor in the cell and you can now press delete, change the data 
and hit “Enter”.  There are a variety of keyboard tricks as well. Pressing F2 will put you into edit mode as 
well.  
 
You can delete information inside of cells by using the “Delete” key. For example, if I click on “Pat” and 
hit the “Delete” key, it will remove the data. If you want to get “Pat” back, we could simply type it in 
again. However, if we click on the “Undo” button on the Quick Access Toolbar it will bring up “Pat” 
again. The button next to it is the “Redo” button which will erase the “Undo” action. 
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Lesson 7: Formatting – Part 1 
 
In this lesson we’ll learn more about how to format our spreadsheets to make them look more professional. 
We’ll learn more about Alignment, Cell Ranges, and Bold/Italics/Underline. 
 
Now that we know how to enter data into our spreadsheet and we know how to edit that data in case we 
need to make a change, now let’s see how we can format the spreadsheet to make it more professional. 
 
The first thing I’d like to change is the way the column headers don’t line up over the data in our 
spreadsheet. Normally in Excel, text values will align to the left and number values will align to the right. 
 
You can change the alignment of the data by clicking on the Alignment buttons in that group on the Home 
tab.  
 
We can change the alignment in each individual cell. However, to save time, we can change more than one 
the same time by highlighting a range of cells and then clicking on the preferred alignment button. You can 
highlight a range of cells by clicking in the starting cell and dragging your mouse to the ending cell: 
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Cell Ranges can be horizontal or vertical, or they can be rectangular blocks of data as shown below. This 
will be beneficial later when we learn more about formulas and functions. The Cell Range is defined by its 
upper left cell followed by a colon, then followed by its lower right cell. In this example, the Cell Range is 
“C3:D5”.  
 

 
 
 

The next thing I would like to do is Bold my header row. Click your mouse in the starting cell, click and 
drag to the ending cell to highlight the header row. Then click on the “B” in the Font Group on the Ribbon 
to bold the text. If you don’t want them to be bold, simply highlight the cell range again and turn off the 
“B” button. This will work for “Italics” and “Underline” as well. 
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Lesson 8: Formatting – Part 2 
 
In this lesson we’ll continue with formatting, learning how to change the Font, Font Size, Re-Size Rows 
and Columns, and change the Foreground and Background color in our cells. 
 
In the last lesson, we learned how to select a range of cells and make them Bold, Italicized or 
Underlined. Let’s see some more of the Font options in this lesson. 
 
Let’s select A1:E1 again on our spreadsheet. On the Home tab in the Font group you can change the Font 
face, or the way the font looks. Click on the drop down arrow next to the box to see your font options: 
 

 
 
 

As you move your mouse over the options, notice in the background on the spreadsheet itself you will see a 
live preview of the font. This was a new feature in Excel 2007. When you find the font you want, just click 
on it to select it. 
 
You can also change the size of the font by selecting the drop down box next to the font face box.  
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Again, as you move over the options, you’ll see the size of the text change in the background. When you 
see the size value that you like, click on it to select the size. If you don’t find the value that you like, you 
can click right in the box and type in the font size that you want. 
 
You can also click on the “Increase Font Size” and “Decrease Font Size” buttons to change the font size 
in incremental steps. 
 

 
 
 

Now you may notice that in Cell A1 you can only see the word “Sales” instead of “Sales Rep”, but we can 
see in the Formula Bar it still says “Sales Rep”. We can either change the font size or we can widen the 
column since it is too narrow now to display all the text.  
 
In order to Re-Size the width of the column, take your mouse and move it between the column headers. It 
will change to a black double arrow. Then click and drag the column to the width that you want.  
 

 
 
 

Now, if you don’t want to have to guess how wide your column should be, you can double click the mouse 
instead of dragging it to change the column width. Excel will automatically re-size the column to the width 
that it needs to be in order to fit the data. 
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You can Re-Size rows almost the same way you re-size columns. If you move your mouse between the 
boundaries of two rows, you can click and drag the mouse to change the row height. Again, you can just 
double-click the mouse to automatically set the width to fit the height of the data. 
 

 
 

 
Now let’s select Cell A1:E1 again to change the Background or Fill color of the cells. The paint can icon 
in the Font group changes the color of the selected cells when you click on it. The bar underneath the paint 
can displays the current color in the paint can. If you don’t want that color, click on the down arrow to open 
the color palette to select the color that you want. 
  

 
 
 

Again, when you hover over the colors, you can see a live preview in the background on your spreadsheet 
before you select the color you want. 
 
You can also select “No Fill” which would remove the color from the background. We’ll learn more about 
“More Colors” in a future lesson. 
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If you want to change your Foreground or Font color, select the Cell A2:A5 and click on the “A” button 
in the Font group next to the paint can. Again, the bar underneath displays the current color. If you want to 
change that color, click on the down arrow to open the color palette and select the color that you want: 
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Lesson 9: Basic Math – Part 1 
 
In this lesson we’ll learn how to perform basic Math Calculations in Excel, how Formulas work, and 
Basic Math Operators.  
 
Excel is great for storing data, but what if you want to perform some calculations on that data? Let’s see 
how basic math operations work in Excel first. 
 
Click on “Sheet 2” in our workbook to give us some room to play around with math functions. Let’s enter 
data into two different cells as shown. Now let’s add up the values of those numbers. A calculation in Excel 
is like a math problem, only backwards - Z=X+Y. In Excel, X and Y would be replaced with the Cell 
Names that contain the data we want to calculate. We can remove the Z, but we always need to include the 
“=” sign.  
 

 
 
 
When you are done, press “Enter” and the sum will display: 
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One of the nice things about using Excel is that it will automatically recalculate your formulas if the data 
changes in your cells.  
 
If we click on Cell A3 and look at the Formula Bar, we can see the actual formula we used to get the 
result. The cell will always display the result of the formula.  
 

 
 

 
If you want to make a change, you can either make the change right in the cell or in the Formula Bar to 
the formula. 
 
Here are the basic math operators available in Excel and the symbols you would use in your formulas for 
each: 
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You can also use constants in your formulas, which means you don’t need to always use cell values. For 
example, you can use “=A3+3” where “3” is the constant. You can do this with any of the basic math 
operators. 
 
Before we move on to the next lesson, let’s clear our data from the cells on Sheet 2. You can either 
highlight all the cells and click “Delete” or you can click on the top of the column header to get a black 
downward arrow which will highlight the column. Click “Delete” and your data will clear the cells. 
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Lesson 10: Basic Math – Part 2 
 
In this lesson we’ll continue looking at basic math operations in Excel by learning how to get the Average 
of a group of cells and we’ll learn about the Order of Operations. 
 
In our last lesson, we learned how to perform some basic math operations on our data, like addition and 
subtraction. We only added our numbers two at a time though. Let’s say we have more numbers we want to 
add up, like test grades. Enter the data as shown on Sheet 2 of your workbook: 
 

 
 
 

Now let’s say we want to add those numbers together. First, if you highlight that range of cells and look at 
your Status Bar, you can see the sum of the data. You can also see the average, count and max: 
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In order to get the sum into your sheet, click in Cell A6 and type your formula. But if you don’t want to 
type in each cell name individually, all you have to do is click on the Cell to add it into the formula. Make 
sure to include the equal sign and enter the “+” sign after each cell name: 
 

 
 
 
Now if we want to find the Average of these numbers, we would add them together and then divide by the 
number of the items. Notice though that you can’t just put the division at the end of the formula because we 
need to remember the Order of Operations to get the result we want – what do we want to do first before 
going to the next operation. 
 
What we need to do in this formula is add parentheses around the addition portion of the formula and then 
divide that result by 5 in order to get the correct Average: 
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Lesson 11: Save, Load & Print 
 
In this final lesson, we’ll learn how to Save our workbook, Load it again and Print  it. 
 
Make sure your workbook is open to Sheet 1 again. Let’s Save this workbook to our hard drive so we have 
it for later. There are a couple of different ways to do this. 
 
If you click on the floppy disk icon on the Quick Access Toolbar, it will open the “Save As” dialog box.  
 

 
 
 
It will put me in my “Documents” folder. Towards the bottom you can see it says “Book1.xlsx” which 
means it is an Excel document. You may only see “Book1” which is okay. This has to do with your settings 
which will be covered in a later lesson. 
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Make sure the “Save as type” says “Excel Workbook”, which it should by default. You can set-up a 
“Spreadsheets” folder if you like to save your documents like I do, but you don’t have to. We covered 
setting up folders in our Windows Basics courses. 
 
Now I will type in a meaningful name in the “File Name” box – like “Sales Data 2010” – then click on the 
“Save” button on the bottom right of the dialog box.  
 

 
 
 
Now you’ll notice on the top of your Excel Workbook you’ll see the “Sales Data 2010” file name on your 
Title Bar: 
 

 
 

 
If we want to enter data for 2011 and save it, we don’t want to replace the 2010 file. So in order to save the 
new file, go to the File tab, click “Save As” and name and save your new file: 
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Let’s close this workbook file. Remember, in order to do this click on the bottom “X” to close just the 
spreadsheet, not Excel. 
 

 
 

 
To Load a workbook, click on the File tab. On the right-hand side you’ll see a list of recent documents that 
you may have been working on. To open one of these documents, just click on it: 
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If the document that you want is not on the recent documents list, just click on the “Open” folder on the 
left side to look for and open your document: 
 

 
 

 
To open the file once you have found it, you can either double-click on it or click on it once and select 
“Open” at the bottom right. 
 
If you have files that you work with on a regular basis and you want to make sure it stays on the recent 
document list, click on the push pin icon to the right of the document name on the list. This will pin it 
down to your recent documents list. If you un-pin it, it will eventually go away as you work with more 
documents. 
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If you want to create a new workbook and you’re already working in Excel, click on the File tab and the 
“New” folder. This will open up the “New Workbook” window which will have several options for you, 
including templates you can download from Microsoft Office online. We will cover this in future lessons. 
 
For now, just double-click on “Blank Workbook”, or select it and click on “Create” at the bottom right to 
open a blank new workbook. 
 

 
 
 

Finally, once your spreadsheet is built, you may want to Print it. Click on the File tab and go to the 
“Print” option. On the far right you will see a small preview of how the printed document will appear. 
 
You can choose the number of copies and change the printer. When you are ready to print, press the Print 
button. The document is then sent to the chosen printer. 
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Review 
 
Let’s take a moment now to review what we covered in class. 
 

• We learned about the Excel 2010 Interface – i.e., the ribbon, all the different parts of the window, 
the title bar, maximize/minimize, quick access toolbar, the zoom control, etc. 

• We learned how to enter data in a cell 
• We learned how to move around with the mouse, the arrow keys 
• We learned how to edit the data using the formula bar or directly in the cells 
• We learned about “undo” and “redo” 
• We learned how to format our cells – changing font information, alignment of data in the cells, 

bold/italics/underline, foreground and background colors 
• We learned how to re-size rows and columns 
• We learned basic math – different math operators, order of operations, how to add a range of cells 

together and how to average 
• We learned how to save, load and print our sheets 

 
 

RICK’S NOTE: I really do enjoy getting surveys from you! Make 
sure you visit the web page above and fill out the survey for this class. 
Let me know if I’ve moved too fast, and whether or not I covered 
material that was helpful to you! 

 
 
What’s next? Microsoft Office Excel 2010 Beginner Level 2 
 
Contact Us. If you have any questions, visit www.ExcelLearningZone.com/contact or post your 
question(s) on the Student Forum discussion board. 
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Computing shall not be held liable for any errors or omissions in this document. 
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